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1. Introduction 
 

 

COBie is the abbreviation of Construction-Operations Building information exchange, a 

specification used in the handover of Facility Management information. The COBie 

standard was originally developed in the US and BS 1192-4 represents the UK 

implementation of COBie. However, both the COBie Responsibility Matrix and the NBIMS-

US V3 standard documentation provide significant additional useful technical information 

for implementation. COBie (Construction-Operations Building information exchange) 

provides a common structure for the exchange of information about new and existing 

facilities, including both buildings and infrastructure.  

 

It is a spreadsheet data format for the delivery of a subset of building model information, 

rather than geometric model information. 

 

Although GRAPHISOFT ARCHICAD cannot export COBie spreadsheets directly, ARCHICAD’s 

BIM-quality models and IFC data exchange capabilities produces data output that can be 

easily converted into COBie documentation, with the help of free or commercial conversion 

programs. (Figure 1)  

 

 

 
Figure 1 - COBie creation from ARCHICAD 

 

This document aims to provide information that will assist in the provision of COBie from 

Designers. 
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Key documents for designers 

 

There are three key documents that designers should aim to read when building an 

approach to COBie. These are as follows: 

 

1. BS 1192-4:2014 Collaborative production of information. Fulfilling employer’s 

information exchange requirements using COBie. Code of practice – can be 

downloaded at http://bim-level2.org/en/standards/ 

2. COBie Responsibility Matrix v17  

3. NBIMS-US V3 4.2 COBie (plus Annex A) 

 

1.1. Different approaches to producing COBie 
 

COBie can be produced in a number of different ways. COBie production currently in 

practice, typically involves one of the following: 

 

1. Directly from a model authoring tool 

2. Exported and generated externally to a model authoring tool 

 

Whichever methodology is utilised, ultimately, a single file is required to be produced, that 

can be checked. 

It should be noted that using a direct export workflow, may not be fully compatible with an 

exported methodology. Therefore, it is important to understand the proposed 

methodology for COBie production at the outset of a project. The methodology should be 

agreed and documented in the post contract-award BIM Execution Plan (BEP). 

UK-specific 

COBie without EIRs/AIRs 

Following a BIM Level 2 process, it would be expected that comprehensive information 

requirements will have been defined prior to a project commencing by the Employer. This 

is certainly not common place and often Designers are left without any clarity about the 

information to be provided. 

So what should a Designer do? COBie is well documented in BS 1192-4:2014 and there are 

a number of fields which are mandatory. So, the mandatory requirements must be the 

starting place for providing information, in line with the requirements of COBie. 

Beyond this, Designers may wish to integrate other fields as part of their standard 

approach. Where a requirement isn’t clear, the Designer is best confirming what they 

propose back to the Employer. 

http://bim-level2.org/en/standards/
http://projects.buildingsmartalliance.org/files/?artifact_id=4093
https://www.nationalbimstandard.org/files/NBIMS-US_V3_4.2_COBie.pdf
https://www.nationalbimstandard.org/files/NBIMS-US_V3_4.2_COBie_Annex_A.pdf
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1.2. Which tabs are relevant to Designers? 
 

The cells in Blue below represent those that need to be completed by all Designers. The 

Lead Designer / Architect would be expected to complete the Green and Blue information. 

 

 

FACILITY 

   

ASSET 

   

OPERATIONAL     

          

 

FLOOR  

   

TYPE 

   

SPARE     

          

 

SPACE  

   

COMPONENT 

   

RESOURCE     

          

 

ZONE 

   

SYSTEM 

   

JOB     

          

          

          

 

SUPPLEMENTARY 

   

ASSEMBLY 

   

ATTRIBUTE     

          

 

INSTRUCTION 

   

CONNECTION 

   

COORDINATE     

          

 

CONTACT 

   

IMPACT 

   

ISSUE [1]     

          

 

 

   

DOCUMENT [2] 

   

     

 

 

[1] Issues can be included in authored models – for the UK, see PAS 1192-6:2018 – 

although this could be achieved in external databases 

[2] Documents is a list of information associated to assets. This would include Designers 

information listed in the COBie output. This data is likely to be either manually created in 

COBie spreadsheet or generated in an external database. 
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1.3. When should data be produced? 
 

When information is required, should be defined by the Employer in their information 

requirements.  

 

1.4. Which elements should be included? 

 

BS 1192-4:2014 states that all elements can be included in a COBie deliverable. This 

allows the employer to provide a list of elements which will have planned preventative 

maintenance.  

 

However, where an employer doesn’t specify elements, it becomes challenging for 

designers. Therefore, the default position where there is no clear defined requirement, 

must be to follow the original US standard. 

 

The COBie Responsibility Matrix v17 provides a list of both Type Assets and Component 

Assets that should and shouldn’t be included within COBie. 

 

Note: The list is built around IFC4, which is not currently implemented in the UK, so some 

knowledge of IFC standards is necessary here. 

 

  

UK-specific 

However, where COBie has been requested, but clarity on when information is required 

has not been provided, the following would generally be assumed for Designers: 

- CIC 2: Concept (i.e. RIBA Stage 2: Concept Design) – Contact, Facility, Floor, Space and 

Zone 

- CIC 3: Design Development (i.e. RIBA Stage 3: Developed Design) – Stage 2 plus Type, 

Component and System. Space Attributes associated to Room Data Sheets would also 

be provided at this Stage 

- CIC 4: Production Information (i.e. RIBA Stage 4: Technical Design) – Stage 3 plus 

Attributes associated to Types/Components 

- CIC 5: Construction Information (i.e. RIBA Stage 5: Construction) – Stage 4 plus 

RoomTag (client’s final space numbering) field on Space sheet 

http://projects.buildingsmartalliance.org/files/?artifact_id=409
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The following Types/Components are defined as excluded in the COBie Responsibility 

Matrix v17: Beams, Building Element Parts [1], Cable Carrier Fittings, Cable Carrier 

Segments, Cable Fittings (IFC4 only), Cable Segments, Columns, Curtain Walls, Duct Fittings, 

Duct Segments, Fasteners, Footings, Junction Boxes, Mechanical Fasteners [1], Members, 

Piles, Pipe Fittings, Pipe Segments, Plates, Railings, Ramps, Ramp Flights, Reinforcing Bars, 

Reinforcing Meshes, Roofs, Slabs, Stairs, Stair Flights and Walls. 

 

 

If a client does choose to include elements outside of the scope, this should be questioned 

to ascertain the reason for collecting data about these elements. Often these are included 

in requirements because the scope of COBie is misunderstood. 

 

  

UK-specific 

The COBie Responsibility Matrix v17 does not exclude Coverings. This appears in conflict 

with BS 1192-4:2014 which uses Attributes (i.e. CeilingCovering, FloorCovering and 

WallCovering are described in Table 12) associated to Spaces to define Covering 

information. Essentially COBie is capturing Room Data Sheets (RDS) information rather than 

modelled elements. 
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1.5. What values need to be completed by Designers? 
 

The requirements for COBie should be set out in the Employer’s Information 

Requirements. COBie has 4 types of fields: 

 

- Required    (yellow cells)  

- Referenced   (orange cells) 

- Automated    (purple cells) 

- Optional (If Specified).  (green cells) 

 

The Required and Referenced fields must be provided as a minimum to satisfy COBie. 

The information that needs to be provided will vary between designers. 

 

The Lead Designer / Architect must provide the following Required data as a minimum 

to satisfy COBie: 

 

- Facility – Name, CreatedBy, CreatedOn, Category, ProjectName, SiteName, 

LinearUnits, AreaUnits, VolumeUnits, CurrencyUnit and AreaMeasurement 

- Floor – Name, CreatedBy, CreatedOn and Category 

- Space – Name, CreatedBy, CreatedOn, Category and Description 

- Zone – Name, CreatedBy, CreatedOn and Category 

 

All designers must provide the following Required data as a minimum to satisfy COBie: 

 

- Contact – Email, CreatedBy, CreatedOn, Category, Company and Phone 

- Type – Name, CreatedBy, CreatedOn, Category, Description, AssetType, 

NominalLength, NominalWidth and NominalHeight 

- Component – Name, CreatedBy, CreatedOn and Description. 

- System – Name, CreatedBy, CreatedOn and Category. 

 

ARCHICAD will automatically fill the following Referenced and Automated data fields: 

 

- Space – FloorName, ExtSystem, ExtObject, ExtIdentifier 

- Space – SpaceNames, ExtSystem, ExtObject, ExtIdentifier 

- Type – ExtSystem, ExtObject and ExtIdentifier 

- Component – TypeName, Space and ExtSystem, ExtObject and ExtIdentifier 

- System – ComponentNames, ExtSystem, ExtObject and ExtIdentifier 
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1.6. How do you Name items for COBie? 
 

The core principle is that naming should match information on drawings and schedules.  

 

There are two possible approaches to naming: 

 

1. Naming requirements are documented in an Employer’s Information Requirements 

(EIR)  

2. Designers set out their proposed approach in a post contract-award BIM Execution 

Plan (BEP) 

Naming requirements should be considered for Floors, Spaces, Zones, Types, Components 

and Systems. 

 

Setting out naming requirements at the outset of the project means greater consistency 

across a single asset or multiple assets. Additionally, rules can be setup to ensure they 

meet the defined naming requirements. 

UK-specific 

How do you classify items for COBie? 

BS 1192-4:2014 currently recommends Uniclass 1.4 in Table 7. However, Uniclass 2015 has 

been released (April 2016) since this standard was released. The following are now typically 

implemented in lieu of Table 7: 

 

Sheet Column Classification table Example 

Contact Category Uniclass 2015 Table PM Project 

Management 

PM_20_20_54: Manufacturer 

Facility Phase Picklist  CIC 6: Handover 

Facility Category Uniclass 2015 Table En Entities En_20_75_10: Detention 

buildings 

Space Category Uniclass 2015 Table SL Spaces/ 

locations 

SL_20_75_22: Detention cells 

Type Category Uniclass 2015 Table Pr 

Products 

Pr_40_20_96_70: Recessed wash 

basins 

System Category Uniclass 2015 Table Ss System Ss_40_15_75: Sanitary appliance 

systems 
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1.7. Other’s data 
 

Designers are required to produce their own information for inclusion in COBie. However, 

the full data set includes information provided by others. 

 

The following Required fields would not typically be expected from a Designer: 

 

Type: 

Manufacturer, ModelNumber, WarrantyGuarantorParts, WarrantyDurationParts, 

WarrantyGuarantorLabor, WarrantyDurationLabor, WarrantyDurationUnit and 

DurationUnit. 

 

The following Optional (If Specified) fields would not typically be expected from a 

Designer: 

 

Type  

ReplacementCost, ExpectedLife, WarrantyDescription, ModelReference, Shape, Size, 

Color, Finish, Grade, Material, Constituents, Features, AccessibilityPerformance, 

CodePerformance and SustainabilityPerformance 

 

Component 

SerialNumber, InstallationDate, WarrantyStartDate, TagNumber, BarCode and 

AssetIdentifier 

 

There are different methodologies for including this data within COBie. This includes the 

following: 

 

1. Insert data directly into the native authoring tool. 

2. Import data into native authoring tool. 

3. Add data to an exported IFC file. 

4. Add data into an external database to either produce COBie or to create a new 

enhanced IFC for COBie production. 

 

 

IMPORTANT 

Designers need to carefully consider the impact of including other’s data in their native 

models with the first two workflows. COBie does not require all data to be contained in 

native models. In some instances employer’s may request that data is in the native models 

and so the timing, process and potential liability for this data needs to be agreed. 
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1.8. BIM Content 
 

Designers should carefully consider the use of BIM content in projects requiring COBie 

production. Any content used, should meet the specific requirements of the project (e.g. 

meet defined naming requirements) and consider liability for other’s data if it is included in 

the content. 

 

Consideration also needs to be given to using manufacturer’s content, that may be 

substituted for different products at a later date. Designers therefore, should carefully 

consider who is responsible for updating product information. Duplicate attributes and 

rogue data should also be considered. 

 

1.9. Who generates COBie? 
 

The party required to produce COBie is often not defined. However, it is typically carried 

out by an Information Manager (IM). The IM is not responsible for the content, this still lies 

with the originating party (i.e. the Designer), however the IM should check the information 

to ensure it meets the specific requirements of COBie. Any issues with the COBie file will 

need to be fed back to the correct designer to resolve either before the stage is complete 

or during the following stage. 
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1.10. What is the relationship between IFC and COBie? 
 

 

The COBie spreadsheet is a mapping of the COBie 2.4 Model View Definition (so-called 

“Model View Definition”; MVD) formally derived from IFC 2x3 Basic FM Handover MVD, 

which is a subset of the current IFC 2x3 scheme. The Basic FM Handover MVD was 

developed by buildingSMART to exchange facility management information among building 

models. ARCHICAD’s IFC 2x3 interface and database support the IFC data and model export 

requirements of the Basic FM Handover View Definition, so most of the values of the COBie 

spreadsheet cells are extracted from IFC models exported by ARCHICAD according to the 

Basic FM Handover MVD settings.  

 

 

 

This guide provides practical information on which data should be added to an ARCHICAD 

project and how to export it as an IFC model to obtain a format, suitable for producing a 

COBie 2 spreadsheet. (The current version of COBie is 2.4.) The final chapter consists of a 

sample workflow using a free IFC → COBie conversion tool recommended by 

buildingSMART. 

 

Although COBie uses the Basic FM Handover MVD, in the IFC translator setup we created 

the COBie 2.4 MVD for COBie related IFC exports.  

 

 

 

  

HINT 

For more information about the relationship between IFC 2x3 Basic FM Handover MVD and 

COBie, visit the buildingSMART website by clicking here. 

For detailed documentation about ARCHICAD’s IFC capabilities, read the ARCHICAD Help 

documentation or read the IFC2x3 Reference Guide. 

NOTE 

This documentation was written based on the currently available COBie – IFC mapping rule 

called “Responsibility Matrix version 17” (published 30th April 2013). 

Although IFC 4 has already been released, COBie 2.4 only uses the IFC 2x3 scheme. 

 

http://www.buildingsmart-tech.org/specifications/ifc-view-definition/fm-handover-aquarium/fm-aquarium-cobie2-description/fm-aquarium-cobie2-description
http://www.graphisoft.com/downloads/addons/ifc/index.html
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The Basic FM Handover View Definition and COBie 2.4 Model View Definition used by COBie 

2 queries includes the following IFC data types from an architectural model and/or its 

elements: 

 

- Owner History data 

- IFC Attributes 

- IFC Properties (standard IFC 2x3 and custom COBie 2-required properties) 

- IFC Classification Reference data 

- IFC Type Product entities 

- IFC Zone assignments 

- IFC System assignments 

- Base quantities 

- Space containment relation 

- Space boundary relation 

 

All these data types are available in ARCHICAD as native ARCHICAD data. The relevant 

properties are automatically mapped to the right IFC properties therefore further action is 

not needed if the provided COBie translator, properties and classification are loaded and 

the IFC translator is set as an Active Preview. 

 

For Contact/Facility level properties, fill up the relevant fields in File > Project Info. You can 

change the property values in IFC Project Manager too in the Project/Site/Facility hierarchy 

level.  

 

For defining Floor level properties, Story Settings and IFC Project Manager can be used 

 

For Space, Type and Component level, properties can be added by using native ARCHICAD 

properties and the mapping to IFC properties are automatically handled by ARCHICAD  

 

For Zone and System level properties, only the IFC Project Manager can be used. 

 

 

COBie is possible without following the required mapping but adds additional work for 

those producing and checking the COBie output, particularly where multiple designers all 

take a different approach. 



14 

 

 

 

1.11. Testing COBie creation 
 

A COBie spreadsheet has strict requirements in order to make sure it is valid. 

 

A COBie spreadsheet can be formally tested for free using the COBie QC (Quality Control) 

Reporter. This is available here:  

https://github.com/OhmSweetOhm/CobieQcReporter/releases 

 

The QC Report should aim to produce a report with ‘0’ or ‘n/a’ in both the ‘Row Warning 

Count’ and ‘Row Error Count’ columns. 

 

The report will demonstrate compliance with the COBie schema, but this does not 

necessarily mean that the data is correct! Other checks should take place outside of the 

COBie QC Reporter to ensure the data is reliable. 

 

 
Figure 2 - COBie Quality Control HTML report from COBie toolkit 

UK-specific 

Much of the UK documentation has been developed around the IFC4 schema. However 

current implementation of COBie using IFC is built around the IFC2x3 version of the 

schema. COBie utilising IFC2x3 requires that Electric Distribution Points are included. This 

presents an issue as Electric Distribution Points, Tendons and Tendon Anchors do not have 

a Type in IFC2x3. This means workarounds are required when using IFC2x3 (i.e. one solution 

involves adding required Type data at Component level). 

 

The same would be true if Footings, Piles, Ramps, Reinforcing Bars, Reinforcing Meshes, 

Roofs, Stairs were required to be included in COBie with an IFC2x3 workflow. 

https://github.com/OhmSweetOhm/CobieQcReporter/releases
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1.12. Possible implementation methods of COBie into your project 
 

 

Incorporating COBie data into the BIM model can be done by several methods. Basically, 

two possible ways are available for the implementation. The way it will be implemented in 

the practice should be decided by the company BIM Manager. Both methods have their 

benefits and company-by-company or project-by-project different ways should be chosen. 

 

The main difference between the methods is how they drive the COBie required properties 

and how the property mapping is done in the background. Both methods are identical in 

properties and function but the way how to put the COBie related properties into the 

model is completely different.  

 

The two methods: 

1. National classification system (Uniclass 2015 / Omniclass / Other) driven property 

mapping 

2. ARCHICAD classification (IFC) driven property mapping 

 

National classification system driven property mapping 
 

In the National classification system driven property mapping the users must classify all the 

relevant model elements in that particular system to be able to add the COBie related 

properties.  

This means if an element is not classified in Uniclass 2015/Omniclass, the relevant COBie 

properties are not showing up. As the IFC export is almost always driven by the ARCHICAD 

-22 Classification, every element should be classified two times; one in ARCHCIAD 22 

Classification and one in in Uniclass 2015 / Omniclass classification system. 

 

Pro 

If an element is not classified in Uniclass2015/Omniclass, related COBie properties are not 

showing up to be filled. This helps the users to classify every necessary element before 

adding the property values. Also it ensures, that every element which has a COBie property 

are classified in the national classification system too. 

 

Con 

Properties are driven by Uniclass2015/Omniclass classification system, therefore every 

change in the classification system needs manual update in the Property 

Manager/Classification manager. 

 

Recommendation 
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This method is recommended for those companies who are not familiar with IFC Type and 

Property mapping. This method is described in detail in this guide. 

 

ARCHICAD 22 classification driven property mapping 
 

In the ARCHICAD 22 classification driven property mapping the 3D model elements are 

assigned to a ARCHICAD 22 classification by default, therefore COBie properties are 

showing up automatically, when a COBie required element is created. 

Uniclass2015/Omniclass classification is still necessary but properties are not driven by the 

existence of this classification for an element.  

 

Pro 

The ARCHICAD classification is a given and the COBie related properties are showing up 

automatically for the relevant elements because all of the tools are assigned to a ARCHICAD 

22 classification by default.   

The IFC classification is not changing therefore if there is no change in the ARCHICAD 22 

classification, no further action is needed for being up to date. 

 

Con 

If the ARCHICAD 22 Classification is modified or new items are added into, manual update 

of the Classification/Property connection should be managed.  

Uniclass 2015/Omniclass classification is still a must but this method allows for a model 

element to have COBie properties without a Uniclass2015/Omniclass classification which 

can end up in a wrong COBie spreadsheet easily. 

 

Recommendation 

 

This method is recommended for those companies who are familiar with IFC Type and 

Property mapping. 
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2. Workflow – Project preparation, importing provided template material 
 

2.1. Importing COBie properties and IFC translator 

 

To display the COBie 2-required and relevant IFC data in IFC data management dialogs, the 

following steps should be followed.  

 

1. Open Options > Classification Manager and import the required classification system by 

using one of the provided PLN files. Each file contains the Classification System 

(Omniclass or Uniclass 2015), the relevant COBie properties and IFC translator. If the 

Omniclass or Uniclass 2015 Classification is already in use in your project, only import the 

properties from the Property Manager and IFC translator.  

 

2. If you import the Classification System and you check the “Include Properties from Files” 

checkbox, the properties will automatically be imported. (Figure 3) 

 

3. After the Classification System and Properties are imported, the IFC translator shall be 

imported into the Export IFC translators. (Figure 4) 

 

 

 

  

IMPORTANT 

To be able to use the predefined setting in your project, always follow the  

1. Classification System > 2. Properties > 3. IFC Translator order. In case of importing the 

translator first than the properties and classification system, the mapping between 

ARCHICAD properties and IFC properties will be missed!  

 Follow the import order below: 

1. Classification System   

2. Properties  

3. IFC Translator 
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STEP 1-2: Importing the Classification System and Properties 

 

Open Options > Classification Manager / Property Manager to start the process and follow 

the steps on Figure 3. 

 

 
Figure 3 - STEP 1-2: Importing Classification Systems and Properties 

  

HINT 

The reason there are multiple COBie 2 scheme files is that the Category definitions required 

by COBie use different classification standards in different countries. For example, the U.S. 

uses the OmniClass standard to categorize Facility, Space and Type, while the UK uses 

Uniclass 2015. Obviously, you should fill out only one Classification Reference data (since 

COBie requires one data) – the one which best expresses the Category definition required 

by COBie for the specific element. 

IMPORTANT 

In the classification system examples only OmniClass and Uniclass 2015 are mentioned. 

These are the two most common systems to be used, but other classification systems 

like Uniformat, Masterformat, CAWS, NBS and many more can be used for COBie creation 

after some adjustments in the property mapping. 
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UK-specific 

 

The ARCHICAD 22 UKI template contains the ‘ARCHICAD Classification – 22’ and ‘Uniclass 2015 

– January 2018’ classification systems by default.  

To be able to use the COBie template, rename the ‘Uniclass 2015 – January 2018’ 

classification system to ‘Uniclass - 2015’ in the Options > Classification Manager as the 

naming of the classification system was changed by GRAPHISOFT. 

 

If the name is retyped accordingly, the importing process of the properties and 

classifications can be started. If the naming is not changed, a third classification system is 

going to be created. 

Browse for the ‘COBie_2_Export_Template_AC22_Uniclass2015_with_BS1192.pln’ file with 

the Classification Manager’s Import button and follow the steps described on page 18. 

Choose the Replace button when the warning message appears.  

 

The replacing keeps the existing property-classification associations and adds the new 

COBie related ones as well.  

 

Note, if you have used IFC property mapping according to the ‘Uniclass 2015 – January 2018’ 

classification, you need to readjust it in the Property Mapping part of the IFC translator 

according to the new naming. 
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STEP 3: Importing the IFC translator 

 

Open File > Interoperability > IFC > IFC Translators and follow the steps on Figure 4.  

 

 
 

Figure 4 – STEP 3 - Importing ‘COBie 2 Export’ IFC translator into current project 

 

It is recommended using the ‘COBie 2 Export’ ARCHICAD translator as an active preview 

(Figure 5): this filters the IFC standard scheme to show only the required COBie data fields 

throughout the user interface. To set an IFC translator as an Active translator, select the 

export translator and hit the ‘Set Preview’ button. A small ARCHICAD icon indicates the active 

translator.  

 

 
Figure 5 - Set IFC translator as active preview 
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Figure 6 - Selecting Model Filter and Type Mapping presets 

  

IMPORTANT 

After importing the translator, please select the proper Model Filter and Type Mapping 

conversion preset for your project.  The recommended preset for:  

Model Filter is ‘All 3D elements’ and for 

Type Mapping is ‘ARCHICAD Classification – 22’ 

but custom ones can be used if necessary. (Figure 6) 
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2.2. How does the template file work? 
              

As the Classification, Properties and IFC Translator is loaded in the project, everything is 

prepared for adding the COBie-related data into the model. In the IFC translator, certain 

Converison Presets are provided by GRAPHISOFT with a “COBie 2” prefix in the names. 

 

In the Geometry Conversion preset, the “Use BREP geometry in current color for all elements” 

and “Explode Composite and Complex Profile elements into parts” are checked for proper 

geometry conversion. 

 

In the Property Mapping preset, certain mapping rules can be changed according to 

company standards or needs. (Figure 7) 

 

 
Figure 7 - Mapping rule setup of COBie required properties (Scheme Setup) 
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In the Data Conversion preset, “Only properties set in Property Mapping for the selected 

Translator” is set for exporting only the COBie relevant properties. Also, IFC Base Quantities, 

IFC Space Containment and IFC Space Boundaries are necessary. (Figure 8) 

 

 

 
 

 

 

Figure 8 - Data Conversion preset 

In the Unit Conversion preset, general units are set. Please select the required Currency Unit 

if the predefined one is inadequate. (Figure 9) 

 

 
Figure 9 - Unit Conversion preset 
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In the IFC data management dialog boxes, click the Show only scheme items icon  to 

filter the full IFC database to show only the loaded COBie scheme data (if the ‘COBie 2 Export’ 

translator is the active preview). If this icon is activated, all data fields that are not part of 

the scheme definition are hidden on the interface: this helps you check the final data which 

is only relevant for COBie. (Figure 10) 

For example, data fields inherited from ARCHICAD that are not part of the COBie scheme 

(such as “Structural Function”, “Position”, “Renovation Status”, etc.) will be hidden. The same 

is true of application-specific, custom IFC data fields which were added earlier to the 

project, as a result of model exchanges with other applications (e.g. structural or MEP), but 

which are irrelevant to COBie. The following chapters summarize the data (required from 

a design application) to be provided in ARCHICAD by the COBie 2 spreadsheet. 

 

 
Figure 10 - Show only scheme items filter 

IMPORTANT 

All Conversion presets must be compliant with the Basic FM and COBie 2.4 Model View 

Definitions. 
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3. Key to tables of this guide 
 

 
Figure 11 - The worksheets of the COBie 2 spreadsheet 

 

Key to tables displayed in the following sections of this document (Figure 12): 

 

 COBie 2 data taken directly from data that was input in ARCHICAD. In other 

words, the ARCHICAD and IFC data types corresponding to these COBie data 

must be set or created in the ARCHICAD model. 

 

 COBie 2 data that are automatically extracted from the ARCHICAD model, 

project settings and their IFC export. In other words, these COBie data are set 

automatically in ARCHICAD; no extra data definition is required from the 

ARCHICAD user. 

 

 
Figure 12 - Key to tables of this document 
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3.1. Contact 
 

The COBie 2 Contact worksheet summarizes the person and organization data of the 

project / model designer. 

 
Figure 13 - Mapping between ARCHICAD model data and the COBie 2 Contact worksheet data 

ARCHICAD project data must be assigned to correspond with the COBie 2 items marked in 

green. All “Contact” data can be entered in ARCHICAD’s Project Info (File > Info> Project Info) 

dialog box. (Figure 14) 

 
Figure 14 - Contact data in ARCHICAD (Project Info) 
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3.2. Facility 
 

The COBie 2 Facility worksheet summarizes the Facility (IfcBuilding), the Project (IfcProject) 

and the Site (IfcSite) data. 

 

 
Figure 15 - Mapping between ARCHICAD model and the COBie 2 Facility worksheet data 

 

All major Facility data can be defined in the Project Info dialog (File > Info). These data can 

also be managed in the IFC Project Manager as the main Attributes of the IfcProject, IfcSite 

and IfcBuilding entities. (Figure 16) 

 

 
Figure 16 - Facility data in ARCHICAD (Project Info) 
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To set the Facility “Category”, provide the proper Classification Reference value in the IFC 

Project Manager. COBie requires IfcBuilding classification by OmniClass table 11, entitled 

“Construction Entities by Function” (in US) or by the Uniclass 2015 system (in UK). Both 

systems are available as built-in classification rules in ARCHICAD under the Apply Predefined 

Rule option in the File > Interoperability > IFC > IFC Project Manager. (Figure 17) 

 

  
 

 

 

Figure 17 - COBie Facility Category set by the proper OmniClass or Uniclass 2015 classification system (IFC Project Manager) 

  

 

 

 

 

 

As the content of classification systems may be updated frequently, absence of certain 

entities can occur in ARCHICAD’s Apply Predefine Rule. Please always check the relevant 

source to be able to use the most updated version of the classification entities. For example 

in case of Uniclass 2015, please check the source page regularly. If a necessary classification 

code and entity is missing, please fill the Classification Reference field manually by 

following the steps below (Figure 18).   

 

https://toolkit.thenbs.com/articles/classification/
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Figure 18 - COBie Facility Category set manually (IFC Project Manager) 

The COBie-required unit systems of the Facility can be set at ‘COBie 2 Export’ IFC translator 

> Unit Conversion. There is a predefined settings package (so-called “IFC Translation Setup” 

in ARCHICAD) which contains export options optimized for the COBie-required IFC export.  

 

Multi Building Definition  

 

By default, ARCHICAD assigns identical “GlobalId” Attributes to IfcProject (Project), IfcSite 

(Site), IfcBuilding (Facility), and IfcBuildingStorey (Floor). More precisely: the “GlobalIds” will 

be identical, provided that the respective ID fields, defined at ARCHICAD’s Project Info dialog 

box (File > Info) contain identical keywords (or no value at all). However, you can alter these 

keywords in the Project Info dialog box to control whether the spatial entities have identical 

or different “GlobalIds”. 

 

Suppose you have two separate buildings (stored in two different ARCHICAD projects). You 

want both projects and both sites to share the same “GlobalId”; yet you want the various 

buildings on each site to have different “GlobalIds”. 

 

To achieve this, enter the same keyword in the “Project ID” and “Site ID” fields of both 

projects. Enter different keywords for the “Building ID” fields. 

 

IfcBuildingStorey (Floor) entities have no corresponding ID field in the Project Info dialog 

box. The “GlobalIds” of IfcBuildingStorey entities are derived from their “Building ID”. If two 

buildings in two different ARCHICAD projects have the same “Building ID”, then all stories 

of those buildings which have the same Story number (“No.”) will have the same “GlobalId”. 

(Figure 19) 
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Figure 19 - Multi-building definition in ARCHICAD (Project Info) 
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3.3. Floor 
 

The COBie 2 Floor worksheet summarizes data of the building stories (IfcBuildingStorey). 

 

 
Figure 20 - Mapping between ARCHICAD model and the COBie 2 Floor worksheet data 

The “Floors” are interpreted as Stories in the ARCHICAD project. The story names (COBie 

“Name”), the elevation (COBie “Elevation”) and the height (COBie “Height”) can be defined in 

the Story Settings dialog (Design > Story Settings). (Figure 21) 

 

 

 

 

 
Figure 21 - Story settings define the major COBie Floor data in ARCHICAD 

  

To set the Floor “Category”, choose the proper “Floor Type” Classification Reference data 

in the IFC Project Manager. Just choose the “COBie Floor and Zone Categories” (Floor Types) 

predefined rule with the Apply Predefined Rule tool. The “Description” attribute of an 

ARCHICAD Story (IfcBuildingStorey) can also be set via the IFC Project Manager. (Figure 22) 

COBie ’Name’ COBie ’Elevation’ COBie ’Height’ 
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Figure 22 - Floor Type definition in the IFC Project Manager 
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3.4. Space 
 

The COBie 2 Space worksheet summarizes data of the Spaces (IfcSpace) of the project. 

 

 
Figure 23 - Mapping between ARCHICAD model and the COBie 2 Space worksheet data 

The “Spaces” are interpreted as Zones (IfcSpaces) in the ARCHICAD project. Thus, the COBie 

2-required data can be set in ARCHICAD Zone Settings. By selecting the correct 

classification of the Zones in the Classification and Properties tab and filling in the Room Tag 

property, our task is complete. 

 

 
Figure 24 -  IfcSpace name and Description settings in ARCHICAD’s Zone tool 

Each COBie Space (ARCHICAD Zone) must have a unique COBie “Name”, that is a unique 

ARCHICAD Zone number (“No”). (Figure 24) 
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To set the Space “Category”, select the proper Uniclass 2015 or Omniclass classification 

entity in the Zone Settings> Classification and Properties > Classifications dialog. COBie 

requires IfcSpace classification by the OmniClass table 13 called “Space by Function” (in the 

U.S.) or by the Uniclass 2015 system (in UK). (Figure 25) 

 

 
Figure 25 - Space Category definition and Room Tag property 

For filling out the Room Tag property, please use the ARCHICAD property from ‘COBie 2: 

Space’ property set.  



35 

 

 

 

 

  

HINT 

Those, who use the ARCHICAD UKI template can also use ARCHICAD Zone Categories for 

setting the Space Category. In this case and additional checkbox has to be selected in the 

IFC translator’s Data Conversion preset to export the relevant data. 

Note that by using ARCHICAD Zone category one IfcSpace entity can only be part of one 

Zone. 

 

IMPORTANT 

For the different classification systems, different templates are available because of the 

different mapping rules. Please select the correct template accordingly with the 

classification system you use. 
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3.5. Zone 
 

The COBie 2 Zone worksheet summarizes the sets of spaces sharing a specific attribute in 

the project. In other words, it summarizes the data of the groups (IfcZones) of COBie 

Spaces (IfcSpaces). 

 

 
Figure 26 - Mapping between ARCHICAD model and the COBie 2 Zone worksheet data 

COBie “Zones” are interpreted as IFC Zone Assignment (IfcZone) entities in the ARCHICAD 

project. An IfcZone entity is a group of ARCHICAD Zone (IfcSpace) entities. IFC Zone entities 

with their COBie 2-required data can be defined and managed only in the IFC Project 

Manager.  

 

A COBie “Zone” (IfcZone) can be defined with the New command by applying it to the “IFC 

Zones” member of the “Assignments” tree. Set the COBie “Name” and the “Description” data 

at the attributes of the same name. To set the Zone “Category”, choose the proper “Zone 

Type” Classification Reference data in the IFC Project Manager. Just choose the “COBie Floor 

and Zone Categories” (Zone Types) predefined rule with the Apply Predefined Rule tool. 

(Figure 27) 

 

HINT 

The main difference between the ARCHICAD Zone Category and IFC Zone is that a room 

(ARCHICAD Zone / IfcSpace) can only be part of only one ARCHICAD Zone Category while 

the very same room can be part of several IFC Zones simultaneously.  
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Figure 27 - COBie 2 Zone (IFC Zone) definition in the IFC Project Manager 

 

 

To assign several ARCHICAD Zones (IfcSpaces) having the same function (on Fig 21 IfcZone 

‘COBie 2: Name’) to a newly created IFC Zone entity, just drag and drop them to the “New 

Relation” folder of the IFC Zone entity.(Figure 28) 

  

HINT 

Use schedules to check all ARCHICAD Zones (IfcSpace) have been assigned to a IfcZone. 

Every Space should be assigned to at least one Zone and every Zone should have at 

least one Space. Spaces however can be assigned to multiple Zones as required. 

IMPORTANT 

Hotlinked ARCHICAD Zone entities cannot be grouped in IFC Zones. To assign an IFC Zone 

entity to these Zones, you must first break their Hotlink module connection. 
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Figure 28 - Grouping ARCHICAD Zones in an IFC Zone (IFC Project Manager) 

 

  

Drag&drop 
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3.6. Type 
 

COBie 2 Type worksheet summarizes the types of equipment and products. 

 

 
Figure 29 - Mapping between ARCHICAD model and the COBie 2 Type worksheet data 

COBie “Types” are interpreted as IFC Type Product entities in the ARCHICAD project. 

ARCHICAD automatically generates IFC Type Product entities for all ARCHICAD element 

types. The following table shows naming examples of the automatically generated IFC Type 

Products. IFC Type Products and their COBie 2-requested data primarily can be defined on 

the element level by using ARCHICAD Properties from the ‘COBie 2: Type’ property set or in 

the IFC Project Manager > Type Products tab by types. (Figure 30) 

 

 
Figure 30 - Naming rule examples of IFC Type Product entities 

   

  



40 

 

In the IFC Scheme Setup (File > Interoperability > IFC > IFC translators > ‘COBie 2 Export’ 

translator > Property Mapping > Map IFC properties for export) command dialog, you can 

override the Type naming with mapping rules. The default ‘COBie 2 Export’ ARCHICAD 

template gives a complex naming rule for IfcWindowStyle (Window Type) and IfcDoorStyle 

(Door Type) naming that contains a custom text ‘DoorStyle_’ or ‘WindowStyle_’ and the 

“Library Part Name”, the “Width” and “Height” parameters with the “Orientation” and some 

static texts among the data values. These rules can be changed or modified according 

the requirements for each IfcTypeProduct. For an IfcTypeProduct more than one rule can 

be created by using sequences. The first rule which is applicable on the Type will be used 

(priority of rules is considered) and the rest of the rules will be ignored.(Figure 32) 

 

 
Figure 31 - Name mapping by the IFC Scheme Setup command 

 
Figure 32 - The effect of the scheme-driven DoorStyle mapping (IFC Project Manager) 

 

All Type names must be unique. Consistent naming of Types is necessary and can be 

changed according your company standards by changing the mapping rules. 
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Type names also can be modified manually. To modify the predefined name of a Type 

and/or to manage the COBie-required attributes, properties and classification reference 

(COBie Category) of a Type, first you have to set IFC Type Product entity to be editable. 

Apply the Edit/New Type command on the selected Type Product item and manage its 

properties in its property table (right hand side).(Figure 33) 

 

 
Figure 33 - How to make a Type Product entity editable (IFC Project Manager) 

 

If an IFC Type Product is editable, the following functions become available: 

 

- renaming (modification of the “Name” attribute), 

- setting COBie attributes and properties, 

- setting Type Category, and 

- modifying its member content by moving the members into another type. 

 

To set the Type “Category”, select the proper Omniclass or Uniclass 2015 Classification of 

the element in the ARCHICAD tool’s settings dialog. COBie requires IFC Type Product 

classification by the OmniClass table 23 called “Products” (in the U.S.) or by the Uniclass 

2015 system (in UK). (Figure 34) 

If you have to use more than one classifications simultaneously (or multiple tables from 

one classification system), you need to split that classification system into parts or use the 

built-in classification rules in ARCHICAD under the Apply Predefined Rule option.  
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Figure 34 - Automatic mapping of COBie Category definition for Door Type (IfcDoorStyle) entity (IFC Project Manager) 

 

 

IMPORTANT 

As the content of classification systems may be updated frequently, absence of certain 

entities can occur in ARCHICAD’s Apply Predefine Rule. Please always check the relevant 

source to be able to use the correct classification entity. For example in case of Uniclass 

2015, please check the source page. If the necessary classification code and entity is 

missing, please fill the Classification Reference field manually by following the steps below. 

(Figure 35) 

 

https://toolkit.thenbs.com/articles/classification/
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Figure 35 - Manual setup of COBie Category definition for Door Type (IfcDoorStyle) entity (IFC Project Manager) 

 

The COBie-required duration unit can be set in Export Options. There is a predefined 

settings package (so-called “IFC Translation Setup” in ARCHICAD) which contains export 

options optimized for the COBie-required IFC export. It is called “COBie 2 Export” IFC 

Translator. 

 

  

If you create a new Component in your model after Type definition, you can easily drag 

and drop the new Component onto an edited Type in the “Type Products” dialog of the IFC 

Project Manager. 

If you have same type Components in two different Hotlinked modules, you can unify them 

in one common Type (within one COBie Type “ExtIdentifier” (IFC “GlobalId”)) only after you 

break their Hotlink module connection. 
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3.7. Component 
 

The COBie 2 Component worksheet summarizes the individually named items of the 

project. 

 

 
Figure 36 - Mapping between ARCHICAD model and the COBie 2 Component worksheet data 

The “Name” data are derived from the ARCHICAD “ID” of the element, so you can set them 

in the element Settings dialogs. All IFC data can be set by using the ARCHICAD Properties 

from the COBie 2: Component property set if a Uniclass 2015 or Omniclass classification is 

assigned to the element. (Figure 37) 

 

 
Figure 37 - COBie-required Component property data set in the Window Settings dialog 

Each Component has to have a unique COBie “Name” (ARCHICAD “ID”). If you did not 

assign unique (different) ID’s to your ARCHICAD elements, you can do so at any time, for 

example using the Element ID Manager function (Document > Listing Extras > Schedules and 

Lists). Also, make sure to know the behaviour of this tool when re-IDing elements is coming 

to picture. 
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3.8. System 
 

The COBie 2 System worksheet summarizes the sets of Components providing a service. 

In other words, it summarizes the data of the systems (IfcSystem) of the project elements. 

 

 
Figure 38 - Mapping between ARCHICAD model and the COBie 2 System worksheet data 

COBie “Systems” are interpreted as IFC System Assignment (IfcSystem) entities in the 

ARCHICAD project. An IfcSystem entity is a group of ARCHICAD elements. IFC System 

entities with their COBie 2-required data can be defined and managed only in the IFC Project 

Manager. 

 

A COBie “System” (IfcSystem) can be defined with the New command by applying it to the 

“IFC Systems” member of the “Assignments” tree. Set the COBie “Name” and the 

“Description” using the attribute fields of the same name. (Figure 39) 

 

To set the System “Category”, select proper Classification Reference data in the IFC Project 

Manager. COBie requires IFC System classification by the OmniClass table 21 called 

“Elements” (in the U.S.) or by the Uniclass 2015 system (in UK). Both systems are available 

as built-in classification rules in ARCHICAD under the Apply Predefined Rule option. 

 

 

Systems are often created by the MEP engineers therefore the architects/designers can 

leave this work for the discipline. In this situation, the MEP engineer is responsible for the 

“System” related information. Later on that COBIE output has to be merged together with 

the architectural COBie data. 

However, if the MEP modeler add-on is installed in ARCHICAD, MEP systems can be 

recognized automatically and System related information can be exported along with the 

architectural model. If the Systems and related elements are not native ARCHICAD 

elements, always test the exported output. 
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Figure 39 - COBie 2 System (IFC System) definition in the IFC Project Manager 

 

 

To assign ARCHICAD elements having the same function (for example elevators) to a newly 

created IFC System entity, just drag and drop them to the “New Relation” folder of the IFC 

System entity. (Figure 40) 

As the content of classification systems may be updated frequently, absence of certain 

entities can occur in ARCHICAD’s Apply Predefine Rule. Please always check the relevant 

source to be able to use the correct classification entity. For example in case of Uniclass 

2015, please check the source page. If the necessary classification code and entity is 

missing, please fill the Classification Reference field manually by following the steps below. 

https://toolkit.thenbs.com/articles/classification/
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Figure 40 - Grouping ARCHICAD elements in an IFC System (IFC Project Manager) 

 

MEP Systems defined with the GRAPHISOFT MEP Modeler Add-On can be also handled as 

IfcSystem inside an ARCHICAD project. Just create a new IfcSystem (as mentioned above) 

and choose the predefined MEP System name from the available list . () 

If an IFC model exported by an MEP application is merged to an ARCHICAD project, you can 

also manage its MEP systems and their properties in the IFC Project Manager. 

drag&drop 

Hotlinked Components (ARCHICAD elements) cannot be grouped in IFC Systems. To assign 

an IFC System entity to these elements, you must break their Hotlink module connection. 

http://www.graphisoft.com/archicad/mep_modeler/
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Figure 41 - Conversion of a MEP Modeler System to an IFC System (IFC Project Manager) 

  

 

  

drag&drop 

UK-specific 

BS 1192-4 defines Systems as a required sheet for COBie. This presents some challenges 

for some software where using an IFC to COBie workflow as not all software support the 

concept of Systems for all disciplines. This means workarounds are currently necessary to 

include System data in an IFC file. 

 

The resultant file may mean that a true IfcSystem is not created and instead properties are 

used to provide the data. 
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3.9. Attribute  
 

Ideally, required Attributes should be specified by the employer as this allows for optimum 

exchange. 

 

Alternatively, it is recommended that Designers confirm the Attributes they will provide to 

the Information Manager (IM) for inclusion in COBie. This will allow the IM, to only include 

Attributes that have been completed and more importantly checked. 

 

3.10. Coordinates 
 

The coordinate data is automated from software. Whilst coordinates are automated, there 

is an argument to say that this data is largely redundant to those maintaining buildings, 

who primarily want to know about the relationship of a Component to its Space. For this 

reason, there have been suggestions that coordinates will be removed from future versions 

of COBie.  

 

3.11. Document / PickLists 
 

Data are extracted automatically from the IFC model exported by ARCHICAD. 

 

3.12. Assembly / Connection / Spare / Resource / Job / Impact / Issue 

 

At present model authoring tools have not been certified or tested for exchange of 

Assembly and Connection data. These sheets would typically need to be completed 

externally to model authoring tools, if they are required. 

 

These data types are not requested from a design application by the COBie 2 rules, and 

they are not available in ARCHICAD projects either. The table contents should be manually 

filled out in the spreadsheet, if they are required. 

 

 

  

UK-specific 

It should be noted that the example for Assembly in BS 1192-4:2014 shows an example of 

a floor build-up but this would not be included if the exclusion list is followed in the COBie 

Responsibility Matrix v17. 
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4. Workflow – Data export 
 

The COBie-required IFC model/file can be exported easily by using the export set (i.e. IFC 

Translator) optimized for the COBie 2 requirements. Just use the Save as command (File 

menu) together with the translator called “COBie 2 Export” a 3D window (preferably) or 

floor plan view. 

 

   
Figure 42 - IFC model export optimized for COBie 2 requirements (Save as) 

 

4.1. The steps of IFC model export to COBie 2 
 

1. Filter elements for the export (use the following options): 

 

- Selected elements only (available only if elements have been selected): 

elements selected in the current view (the view that was open when you issued the 

Save as command) will be exported. 

 

- Entire project: 

entire model (regardless of any selection, and regardless of the shown/hidden 

status of the elements’ layers) will be exported. 

 

- Visible elements: 

 

the visible elements in the current view will be exported, regardless of any selection. 

“Visible” means all elements that are set to be displayed (due to Layer Settings, Model 

View Options, Partial Structure Display, etc.). 
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2. Choose the “COBie 2 Export” Translator, in which export settings are fine-tuned for 

the COBie 2 requirements. The meaning of the major export options (Derived model data 

to export options) of the “COBie 2 Export” Translator is the following (check Data Settings): 

 

- Space containment: 

It exports the relationship between ARCHICAD Zones (IfcSpaces) and their contained 

Object (Furnishing, MEP Equipment, etc.) and Morph elements. “Contained” means 

that the midpoint of an Object or Morph is within an ARCHICAD Zone in the 3D 

space. This option is required for exporting COBie “Space” data of the Component 

worksheet. 

 

- IFC base quantities (size, area and volume): 

It exports elements’ base quantities required by COBie 2. 

 

- IFC Space boundaries: 

It exports the logical connection between ARCHICAD Zones (IfcSpace) and the 

building elements that enclose them. This option is also required for exporting 

COBie “Space” data of the Component worksheet.  

 

3. Set the model units (“IFC model units”). 

 

4. Define file name. 

 

5. Set the file format to .IFC or .IFCXML depending on the file support of the COBie 2 

spreadsheet converter program.  

 

6. Click Save. 

IMPORTANT 

If you issue the export command from Floor Plan view (“Visible elements (on all stories)”), 

this choice includes all elements currently displayed on every story of the project. 

If you choose “Visible elements”, make sure that ARCHICAD Zones are set to be displayed 

in the current view. For example, if you are saving from the 3D window, make sure that 

Zones are “on” in the Filter and Cut Elements in 3D dialog box (View > Elements in 3D View). 

Filtering model elements required for COBie within ARCHICAD is not necessary, as during 

the COBie spreadsheet generation, the responsible converter tools are filtering for the 

necessary elements automatically. 
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5. Workflow – COBie Spreadsheet creation 
 

An external application is needed to convert an ARCHICAD IFC file to an XML-type COBie 2 

spreadsheet format. 

 

The IFC and COBie 2 spreadsheet formats for the IFC 2x3 Basic FM Handover MVD, capture 

the same information content and can be transformed forth and back, across the different 

formats. COBie from IFC transformations are implemented according to the so-called 

“COBie Responsibility Matrix” document. This document, defines the mapping rules 

between the IFC file and the COBie spreadsheet and which IFC entity types are allowed to 

be converted to COBie Component and Type entities (“Type Assets” and “Component 

Assets” tables). 

 

A number of dedicated tools can be used to execute the transformations, such as the free 

COBie Toolkit application, developed by Engineer Research and Development Center 

(ERDC) or Solibri Model Checker (SMC) with the COBie extension.  

 

 

 

  

GRAPHISOFT takes no responsibility for creating COBie spreadsheet by using third party 

applications. 
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5.1. COBie Toolkit 
 

The COBie Toolkit is a free application and can be downloaded from the buildingSMART 

homepage. 

 

ERDC COBie Toolkit, developed for the COBie FM Handover project, includes the 

transformer tool and the configurations to map IFC data to COBie 2. The conversion can 

be done in two easy steps.  

 

1. Open the COBie toolkit (the file with .JAR extension) 

 

Press the Start button to run the application. (Figure 43) 

 

In case of very large IFC models, modify the memory options (by increasing the “Max 

Heap Size”, “Max Perm Size” and “Stack Size”) in the COBie Toolkit Starter dialog. 

 

 

 
Figure 43 - COBie toolkit starter 

  

  

In order to be able to generate the COBie spreadsheets from an IFC file, JAVA is required. 

On WIN platform, the latest JAVA version must be installed.  

On MAC platform, the latest JAVA and Java SE Development Kit 8 must be installed 
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2. Open the COBie toolkit (the file with .JAR extension) 

 

Click on the Import button to browse for IFC files to be loaded.  

 

  
Figure 44 - Opening IFC files into COBie toolkit 

 3. Export COBie spreadsheet 

 

Click on the Export/Report button and choose the COBie Spreadsheet XML (2003) (xml)  

  

 
Figure 45 - Exporting COBie spreadsheet 

 

If you choose the “COBie QC Report - Design Deliverable” export format, the application 

checks for any missing items in your IFC model. This quality check presents a summary of 

various checks performed on the COBie data: e.g. at least one Component for each Type, 

unique names for Types, at least one Floor, etc. 
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4. Open the COBie file in a spreadsheet application 

 

Open the file and check if all relevant tabs have information included. 

 

 
Figure 46 - COBie spreadsheet 
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Additional Info 

 

Based on the COBie Responsibility Matrix (“Type Assets” and “Component Assets” tables), 

the COBie Toolkit ignores some IFC entity types (e.g. IfcWallType, IfcWall, 

IfcWallStandardCase) by default. If you would like to allow all IFC entity type conversion to 

COBie Types and Components, change the “COBieIDMPlugin” mode to “None” at “Options”. 

 

 
Figure 47 - IFC Entity and Type Products ignored in the IFC to COBie conversion by default 
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5.2. SOLIBRI MODEL CHECKER 
 

Please follow the official Solibri guidelines to be able to create the COBie spreadsheet with 

the use of SMC. By default, SMC will not create automatically the COBie documentation 

from an IFC file prepared by following this guide.  

 

 

 

  

SMC requires further Information Take-off setup to locate and extract the proper data for 

COBie spreadsheet creation automatically.  
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Appendix 1 - BS 1192-4 specific properties 
 

BS 1192-4 specific properties are added to the Uniclass 2015 template file. 

 

The following properties are included in the Uniclass 2015 template 

Facility 

 

Facility related properties can only be entered manually in the IFC Project Manager. 

 

Location in 

ARCHICAD 

Name of Property Set Name of Property Data creation 

IfcSite Pset_SiteCommon LandTitleNumber Manual entry 

IfcBuilding Pset_BuildingCommon IsLandmarked Manual entry 

IfcBuilding Pset_BuildingCommon BuildingID Manual entry 

IfcBuilding Pset_BuildingCommon IsPermanentID Manual entry 

IfcBuilding Pset_BuildingCommon OccupancyType Manual entry 

IfcBuilding Pset_BuildingCommon_UK RefEasting Manual entry 

IfcBuilding Pset_BuildingCommon_UK RefNorthing Manual entry 

IfcBuilding Pset_BuildingCommon_UK UPRN Manual entry 

IfcBuilding Pset_BuildingCommon_UK TOID Manual entry 

 

 

Space 

 

Space related properties are Automatically Mapped (AM) from different sources. Mapping 

rules can be seen and changed in the IFC Translator > Property Mapping. 

 

Location in 

ARCHICAD 

Name of Property Set Name of Property Data creation in  

ARCHICAD 

IfcSpace Pset_SpaceCommon Capacity AM from AC Properties 

IfcSpace Pset_SpaceCommon Category AM from Zone Category 

IfcSpace Pset_SpaceCommon CeilingCovering Mapping rule  

IfcSpace Pset_SpaceCommon Concealed AM from AC Properties 

IfcSpace Pset_SpaceCommon FinishCeilingHeight Mapping rule 

IfcSpace Pset_SpaceCommon FloorCovering Mapping rule 

IfcSpace Pset_SpaceCommon InteriorOrExteriorSpace AM from AC Properties 

IfcSpace Pset_SpaceCommon OccupancyNumber AM from AC Properties 

IfcSpace Pset_SpaceCommon Utilization AM from AC Properties 
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Component 

 

Component related properties are Automatically Mapped (AM) from ARCHICAD properties.  

 

Location in 

ARCHICAD 

Name of Property Set Name of Property Data creation in  

ARCHICAD 

IfcElement Pset_Criticality Criticality AM from AC 

Properties 

IfcElement Pset_Condition AssessmentDate AM from AC 

Properties 

IfcElement Pset_Condition AssessmentDescription AM from AC 

Properties 

IfcElement Pset_Condition AssessmentCondition AM from AC 

Properties 

IfcElement Pset_ComponentCommon_UK AssetStatus AM from AC 

Properties 

 

 

  

Additional properties can be added in the Property Manager but make sure to create the 

proper mapping rules in the IFC Translator to have those properties exported.   
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Appendix 2 – List of necessary and unnecessary IFC entities for COBie 
 

It is recommended not to filter any of the elements from the IFC Translator. Associative 

elements, like windows, doors, skylights, etc. may end up not being exported if their host is 

filtered out (IfcWall, IfcSlab, etc.). During the COBie spreadsheet creation, these entities can 

be filtered out, but not for the IFC export. 

 
Included COBie Components 

 

  

Building Element Proxy  IfcBuildingElementProxy 

Chimney  IfcChimney 

Ceiling  IfcCovering with a predefined type: CEILING 

Covering  IfcCovering 

Discrete Accessory  IfcDiscreteAccessory 

Distribution Chamber Element  IfcDistributionChamberElement 

Distribution Control Element  IfcDistributionControlElement 

Distribution Element IfcDistributionElement 

Distribution Flow Element  IfcDistributionFlowElement 

Door IfcDoor and IfcDoorStandardCase 

Duct Flow Terminal  IfcFlowTerminal 

Energy Conversion Device  IfcEnergyConversionDevice 

Flow Controller  IfcFlowController 

Flow Moving Device  IfcFlowMovingDevice 

Flow Storage Device IfcFlowStorageDevice 

Flow Treatment Device fcFlowTreatmentDevice 

Furniture IfcFurnitureElement, IfcFurniture and IfcSystemFurnitureElement 

Lamp IfcFlowTerminal) IfcFlowTerminals 

Light Fixture  IfcFlowTerminal 

Pipe Flow Terminal  IfcFlowTerminal 

Shading Device  IfcShadingDevice 

Tendon  IfcTendon 

Tendon Anchor  IfcTendonAnchor 

Transport Element IfcTransportElement 

Window  IfcWindow and IfcWindowStandardCase   

Excluded COBie Components 
 

  

Beam  IfcBeam and IfcBeamStandardCase 

BuildingElementPart --- 

Cable Carrier Fitting IfcCableCarrierFittingType 

Cable Carrier Segment  IfcCableCarrierSegmentType 

Column IfcColumn and IfcColumnStandardCase 

CurtainWall  IfcCurtainWall 

Duct Fitting  IfcFlowFitting 
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Duct Segment IfcFlowSegment 

Fastener  IfcFastener 

Footing  IfcFooting 

Mechanical Fastener  IfcMechanicalFastener 

Member IfcMember and IfcMemberStandardCase 

Pile  IfcPile 

Pipe Fitting  IfcFlowFitting 

Pipe Segment IfcFlowSegment 

Plate IfcPlate and IfcPlateStandardCase 

Railing  IfcRailing 

Ramp  IfcRamp 

Ramp Flight  IfcRampFlight 

Reinforcing Bar  IfcReinforcingBar 

Reinforcing Mesh IfcReinforcingMesh 

Roof  IfcRoof 

Site Geometry  --- 

Slab  IfcSlab, IfcSlabElementedCase, IfcSlabStandardCase 

Stair IfcStair 

Stair Flight  IfcStairFlight 

Wall  IfcWall, IfcWallElementedCase, IfcWallStandardCase 

 

Included COBie Types  

*Only available in IFC4  

IfcActuatorType 

IfcAirTerminalType 

IfcAirTerminalBoxType 

IfcAirToAirHeatRecoveryType 

IfcAlarmType 

IfcAudioVisualApplianceType* 

IfcBoilerType 

IfcBuildingElementPartType* 

IfcBuildingElementProxyType 

IfcBurnerType* 

IfcChillerType 

IfcChimneyType* 

IfcCoilType 

IfcCommunicationsApplianceType* 

IfcCompressorType 

IfcCooledBeamType 

IfcCoolingTowerType 

IfcCondenserType 

IfcControllerType 
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IfcCoveringType 

IfcDamperType 

IfcDiscreteAccessoryType 

IfcDistributionChamberElementType 

IfcDistributionControlElementType 

IfcDistributionElementType 

IfcDistributionFlowElementType 

IfcDoorStyle 

IfcDoorType* 

IfcDuctSilencerType 

IfcElectricApplianceType 

IfcElectricDistributionBoardType* 

IfcElectricFlowStorageDeviceType 

IfcElectricGeneratorType 

IfcElectricMotorType 

IfcElectricTimeControlType 

IfcElementAssemblyType* 

IfcElementComponentType 

IfcEngineType* 

IfcEnergyConversionDeviceType 

IfcEvaporativeCoolerType 

IfcEvaporatorType 

IfcFanType 

IfcFilterType 

IfcFireSuppressionTerminalType 

IfcFlowControllerType 

IfcFlowInstrumentType 

IfcFlowMeterType 

IfcFlowMovingDeviceType 

IfcFlowStorageDeviceType 

IfcFlowTerminalType 

IfcFlowTreatmentDeviceType 

IfcFootingType* 

IfcFurnitureType 

IfcFurnishingElementType 

IfcGeographicElementType* 

IfcHeatExchangerType 

IfcHumidifierType 

IfcInterceptorType* 

IfcLampType 

IfcLightFixtureType 

IfcMechanicalFastenerType 

IfcMedicalDeviceType* 

IfcMotorConnectionType 
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IfcOutletType 

IfcPileType* 

IfcProtectiveDeviceType 

IfcProtectiveDeviceTrippingUnitType* 

IfcPumpType 

IfcReinforcingBarType* 

IfcReinforcingElementType* 

IfcReinforcingMeshType* 

IfcRoofType* 

IfcSanitaryTerminalType 

IfcSensorType 

IfcShadingDeviceType* 

IfcSolarDeviceType* 

IfcSpaceHeaterType 

IfcStackTerminalType 

IfcSwitchingDeviceType 

IfcSystemFurnitureElementType 

IfcTankType 

IfcTendonType* 

IfcTendonAnchorType* 

IfcTransformerType 

IfcTransportElementType 

IfcTubeBundleType 

IfcUnitaryEquipmentType 

IfcUnitaryControlElementType* 

IfcValveType 

IfcVibrationIsolatorType 

IfcWasteTerminalType 

IfcWindowStyle 

IfcWindowType*  

Excluded COBie Types  

*Only available in IFC4  

IfcBeamType 

IfcCableCarrierFittingType 

IfcCableCarrierSegmentType 

IfcCableFittingType 

IfcCableSegmentType 

IfcColumnType 

IfcCurtainWallType 

IfcDuctFittingType 

IfcDuctSegmentType 
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IfcElementType 

IfcFastenerType 

IfcFlowFittingType 

IfcFlowSegmentType 

IfcJunctionBoxType 

IfcMemberType 

IfcPipeFittingType 

IfcPipeSegmentType 

IfcPlateType 

IfcRailingType 

IfcRampType* 

IfcRampFlightType 

IfcSlabType 

IfcSpaceType 

IfcStairType* 

IfcStairFlightType 

IfcWallType 
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Appendix 3 - References 

 

Help Center links 
 

[1] IFC Project Manager https://helpcenter.graphisoft.com/user-guide/65786/ 

[2] Navigating in IFC Project Manager: Attributes and Properties 

https://helpcenter.graphisoft.com/user-guide/77305/ 

[3] Using Property Mapping https://helpcenter.graphisoft.com/user-guide/77330/  

[4] IFC Translators: Overview https://helpcenter.graphisoft.com/user-guide/65791 

[5] Model View Definitions https://helpcenter.graphisoft.com/user-guide/77337/ 

[6] Bond Bryan Blog https://bimblog.bondbryan.co.uk/cobie/ 
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